
Page 1  The Journal of the Launceston Computer 
Group Inc 

ABN 41 451 764 376 

I NS IDE  T HIS  ISS UE :I NS IDE  T HIS  ISS UE :   

Committee Information  
Ron’s Ramblings 

Page 2 

OPEN News Pages 3-4 

A Brief History of Computing  George Boole Pages 5-7 

Some Interesting Thoughts Page 7 

Portable Advice Pages 8-9 

Computing at Entropy House Page 10 

Editor in a Box Editing in Word Pages 11-12 

Quicker Shutdown Page 12 

Word Field Codes Revealed Pages 12-14 

The Difference Between the Computer Guys And the Civilians Page 15 

Newbie Club Tutorials Pages 16-17 

Phatbot Suspect Released on Bail Page 17 

Cyber Crooks go “Physhing: Page 18 

Committee Meeting Minutes 3rd June 2004 Page 19 

Remove “Any” Software 
That Error 

Page 20 

Newstream Articles 
Deadline : 10 Days before Meeting 
Editors Contacts: 
Address: 8 Cadorna Street Mowbray Heights 7248  Phone 6326 5824 
email address         editor@lcg.org.au 

Correspondence 
Address all Correspondence to: 
                 Launceston Computer Group Inc 
                 PO Box 548 
                 Launceston 7250 

Membership 
Single $10, Family $15 (Includes Email edition Newstream) 

Printed & Posted Newsletter $20 extra 
Disclaimer: The articles in this newsletter may be reprinted as long as credit is given to the original author. 
Opinions expressed are those of the author & not necessarily the views of the Editor or the Group. Unless 
otherwise noted material is copyright 2004 for the Launceston Computer Group Inc. 

Volume 3 Issue  6 
July 2004 

Next meeting 
WEDNESDAY 7TH JULY 

STUDIO WORKS 
COMMITTEE 6 PM 
BEGINNERS 7 PM 

DEMONSTRATIONS 8 PM 



Page 2  Page 2  

Ron’s Ramblings 
Since the last Committee Meeting I have been mulling over the worrying 
division that appears to be developing between the OPEN Computing and 
the parent body, The Launceston Computer Group Inc. 
I appreciate that OPEN contribute a large percentage of our finances, and 
wish to control the expenditure of those finances. 
The problem is that our Constitution under which we are incorporated, 
does not allow Special Interest Groups (SIGs) to approve expenditure. 
Therefore we either change our constitution be a special resolution at our 
AGM, or find a way around the problem. 
There are two possibilities to my thinking, and I throw them into the pot 
for discussion at Committee and OPEN Meetings. 
1. The LCG Committee allow OPEN a large Petty Cash Account, say 

$500-$1000, administered by OPEN and reimbursed by the LCG 
Treasurer after approval at the LCG Committee. 

2. The Treasurer of the LCG Committee is elected from OPEN, 
(provided an appropriate person is available and willing to act) 

Another matter to consider at the AGM, in August, is the financial year of 
the Group. To fit in with the operations of OPEN, it may be convenient to 
have our financial year as the Calendar year, as we do not have to prepare 
tax returns etc. 
Again this will need a change to our Constitution be Special Motion at the 
AGM. 
Please Note: I was wrong in previous “Newstreams” in referring to the 
AGM being in September. I had it in mind because September is the latest 
that the AGM can be held. The AGM will be held on Wednesday 4th 
August at 8 PM at Studio Works 

Position Name After Hours / 
Business 

Email 

President Glenn Gilpin 6330 1129 president@lcg.org.au 

Vice President Ivan Turmine 6327 1825 vicepresident@lcg.org.
au 

Treasurer David Gray 6343 2514 treasurer@lcg.org.au 

Secretary John Frearson 6335 4802 secretary@lcg.org.au 

General Committee    

Library MAC Ivan Turmine 6327 1825 maclibrary@lcg.org.au 

Newstream Editor Ron Baker 6326 5824 editor@lcg.org.au 

Publicity & Promotion Judy Hall 6394 7358 publicity@lcg.org.au 

Assistant Treasurer Iris Meek 6327ᅽ3162ᅽ Assistanttreasurerᅽ
@lcg.org.au 

PC Library Judy Hall 
Julie Hjort 

6394 7358 
6344 5686 
 

pclibrary@lcg.org.au 

Public Officer Judy Hall 6394 7358 publicofficer@lcg.org.
au 

Meetings Chair Ron Baker 6326 5824 committee@lcg.org.
au 

OPEN Chair June Hazzlewood 6327 2562 
0414 770 864 

open@lcg.org.au 

Linux Chair David Gray 6343 2514 linux@lcg.org.au 

WebMaster Chris Ralph  webmaster@lcg.org.au 

Web Editor Reinhardt Von 
Samorzewski 

6327ᅽ1552 web@lcg.org.au 
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OPEN Session Times 
All sessions are held at the venue at  

Studioworks, 1 Pipeworks Rd, L’ton 
Standard Sessions  (All sessions $4.00) 

TAFE eLearn Sessions    
(All sessions $4.00) 

DUE TO FINISH THIS MONTH  

Special May Sessions 

(Continued on page 4) 

Launceston Computer Group 
SOFTWARE LIBRARY 

Dated 1st June 2004 
 

DISK 1000 - Your Library on Disk 
Have you received your copy of Disk 1000? The disk holds a 
complete listing of programs available in our PC shareware library.  
This disk is free of charge to all new members. 
DISK COPY PRICES - CLUB MEMBERS $1.00 per disk 
 
Disk Prices - Box of 25 =  $12.00 Members Only 
CD Prices – Box of 10  = $10.00  Members Only 

Judy Hall ,Shareware Librarian   

 
AVAILABILITY OF LIBRARY 

The Shareware Library is available in-between meetings 
from the following people. Please telephone first to arrange a 
suitable time.  
The library is also available at the venue - Studioworks 
most Wednesdays 9am to 3pm. Email:  
opencomputingtas@hotmail.com 
LAUNCESTON 
Julie Hjort    Phone 6344 5686 
Flat 2, 115 Penquite Road, Newstead Email:  jhjort@intas.net.au 
 
    

Monthly Workshops 
Graphics PSP7 – 21st July  

Next class 
PSP7 – Using Paint Shop Pro 

Wednesday  21st July 
1pm – 3.30pm 

$6.50 fee - Numbers limited to 8 please register on 
noticeboard or call  

Judy 63947358 or 0428 947358. 
---------------------------------------------- 

 
 

 

Family History Online 
Next Classes 

Wednesday 14th Jul 1pm–3.30pm & 
Tuesday 27th Jul  9pm – 12pm 

$4.00 fee     Numbers limited to 8 people 
Please register on noticeboard 

----------------------------------------------- 
Microsoft Publisher 
Next Class 
Thursday 8th Jul - 3pm to 5pm 
Please register on noticeboard – Fee $4.00 

Class sizes limited. 
----------------------------------------------- 

Graphics – Level 1 
This new class will be held every second month and is 
aimed at those people who are new or know little about 

manipulating graphics. 
Wednesday 28th Jul – 1 to 3.30pm 

Please register on noticeboard  
Fee $6.50 Includes both programs. 

----------------------------------------------- 
OPEN Meeting 

 Wednesday 7th Jul. 
A special meeting for all members of OPEN.  We need 
your help.  If you can lend a hand with helping at the 

venue or doing small jobs please come. 
----------------------------------------------- 

VENUE TELEPHONE NUMBER 
A Mobile Phone Number is now available to all those 
wishing to contact OPEN during working hours.  The 
number is  

0413 698 610 

Monday 9am – 12 Beginners 
Monday 1pm – 3pm 2nd Step 
Tuesday 9am – 12 PC & Mac 
Tuesday 1pm – 3pm Beginners 
Wednesday 9am –12 Beginners 
Wednesday 2pm – 4pm 2nd Step 
Thursday 1pm - 3pm PC & Mac 

Monday 9am - 12 eLearn 

Thursday 9am – 12   eLearn 

Thursday 1pm - 3pm eLearn 

Friday 9am - 12 eLearn 

Wednesday   7th  Jul 1pm on OPEN  Meeting & 
Tutor Tutorial 

Wednesday   7th Jul 7pm on LCG Monthly Meeting 

Thursday     8th Jul 3 – 5 MS Publisher 
Wednesday 14th Jul 1 – 3 Family History 
Wednesday 21st Jul 1 – 3 Graphics PSP7 
Tuesday      27th Jul 9–12 Family History 
Wednesday 28th Jul 1 -- 3 Graphics Lev. 1 

OPEN NEWSLETTER - JULY 2004 
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(Continued from page 3) 

What’s Happening at OPEN 
 

OPEN Monthly Meetings  
Open Meeting  7th Jul 2004 at 1.00  
Our regular monthly meeting to deal with all the affairs of 
OPEN.  If you have any ideas please come to the 
meeting and discuss them with everyone. 

------------------------------------------------------ 
 NEW CLASS 

To be held every second month. 
Graphics – Level 1 

Entry level graphics for those people new to computers 
or new to the field of graphics. 

Wednesday 28th July 2004 
1pm – 3.30pm 

 ------------------------------------------------------- 
eLearn Extension 
Those people who have not yet completed eLearn 
assignments may be able to extend the completion time 
to July 30th.  See your Tutor for more details. 
------------------------------------------------------- 
Induction Packs 
Now being collated are the new induction packs which 
will include all the information a new member requires to 
begin their course. 
 
Induction Packs are to be handed out to each new 
member once they have paid their membership. 
------------------------------------------------------- 
Volunteer Hours 
Volunteer Tutors, please remember to log your hours in 
the day book. 
------------------------------------------------------- 
 
 

Fee Alteration - $2 sessions 
Anyone attending a second class within the same 
week can now pay $4.00 for the first session and $2 
for each subsequent session.  
Please Note: Special fee excludes sessions where 
special fees apply ie Graphics. 
----------------------------------------------------------- 
Free Copy of Newsletter 
Don’t forget to submit your email address if you wish to 
receive the LCG/OPEN newsletter via email.  If you 
have not yet received the newsletter via email tell your 
tutor. 
-------------------------------------------------------- 
 
Special Monthly Meetings 

 

Launceston Computer Group Inc. 
1st Wednesday of the month 

Wednesday  7th July 2004 
Evening  7.30pm – 10pm 

 
 

Shareware 
Disk# >>> 3745 <<<Category>>>UT for WIN/W98<<< 
Johnny Castaway Screen Antics 
A great little screensaver.  Follow the adventures of Johnny 
who is stranded on a island in the middle of the ocean.  The 
program was originally written for Windows 3.1 but has been 
given a setup.exe file to install on Windows 95, 98, ME or 
2000.  We have not yet worked out how to get is working on 
XP. 

Waiting Lists 
A waiting list has been drawn up in the back of the 
daybook. Please enter the names and preferred 
sessions and contact numbers in the list.  
------------------------------------------------------- 
Cleaning of the Venue 
A new cleaner has been found and will soon be taking 
up her duties. 
--------------------------------------------------------- 
Northern Tas. Camera Club 
Will now be meeting at the OPEN Rooms once a 
month with the first meeting.  

Saturday Jul 17th 
If you are interesed in modifying your photographs this 
may be of interest to you. 
You will need to join the club. 
--------------------------------------------------------- 
Printing Costs 
With the purchase of the new printer we now have 
photographic quality printing available to all students. 
At this time the cost of printing will remain the same 
but may be reviewed in the future.  Current costs are: 
Photocopying                                                        
                                                                20c per page 
Printing to Kyocera Printer                      20c per page 
Printing black & white text to Canon       20c per page 
Printing text and graphics to Canon        40c per page 
Printing cards or full page graphics        $1.00 per page 
--------------------------------------------------------- 
Bulk Buy Booklets 
The books have now arrived.  Have you got yours.  
Still some books to be collected by Karen Gilbert, J 
Everett, K. Orchard, S. Lewis. 
------------------------------------------------------- 
 
 
 
 

OPEN NEWSLETTER - JULY 2004 
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The truth table for OR is 

 

 

 

 

 

and for XOR 

 

 

 

 

 

NOT is easy 

 

 

 

 

It’s only a short step to replace true and false with 1 and 0, the digits 
of the binary number system, and as Babbage and other pioneers of 
computing realised (sometimes without knowing about Boole) Boolean 
logic is the basis for a binary adder. All that’s needed is the hardware, 
and Konrad Zuse (Germany) and George Stibitz (US) were the first to 
put it into practice, in the 1930s. Each was unaware of the other at the 
time. 

The logic gates, as they are known, are represented by these symbols: 

 

 

 

 

(Continued on page 6) 

A brief history of computing... 
AND, OR, NOT, and all that 

George Boole 
Peter Carter 

George Boole was a contemporary of Charles Babbage, 
who wrote of Boole’s work: “This is the work of a real 
thinker.” Like Babbage, Boole did not live to see the real 
results of his work in the following century. Mathematicians were the first to appre-
ciate his ideas, and Russell and Whitehead, in Principia Mathematica, expanded 
Boole’s thinking into symbolic logic. 

Boole was born in 1815, the son of a tradesman, and in 1849 was appointed Profes-
sor of Mathematics at Cork University even though he held no degree. His first 
book, Mathematical Analysis of Logic, was published in 1847, and the second, In-
vestigation of the Laws of Thought, in 1854. He was awarded the Royal Medal by 
the Royal Society in 1844 and elected a fellow of the Society in 1857. Boole died in 
1864. 

Boole was the first to show clearly that logic was a branch of mathematics, not phi-
losophy, and set out algebraic methods, now known as Boolean algebra. 

The four main operators of Boolean algebra are AND, OR, XOR (excusive OR) and 
NOT. Using them, we can set out truth tables, with that for AND being (T = true, F 
= false) 
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(Continued from page 5) 

The truth table for adding two binary digits is 

 

 

 

 

 

 

Recognise something? For the sum, the truth table is that for XOR, and 
for the carry, AND. We can therefore put two gates together to make a 
half adder  

Two half adders together make an adder, which takes care of the carry 
figure from a previous stage: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A real processor, whether it’s the PowerPC processor in your Mac or 
any other, will be far more complex than that of course, but binary ad-
dition is the basis of it all. 

Hardware 

In 1936 Konrad Zuse, working for an aircraft manufacturer, began 
work on a programmable calculator in his parents’ living room. The Z1 
was mechanical, and not very satisfactory. Its successor, Z2, was built 
around relays, and was more successful. Zuse managed to receive 
funding for a calculator to help solve wing flutter problems, and by 
1941 he had completed the Z3, the first operational general-purpose 
programmable calculator. It contained 2 600 relays. 

Encouraged, Zuse began work on Z4, but in the increasing chaos in 
Germany was unable to complete it before 1950. The Z3 was de-
stroyed. Zuse went on to form his own computer company, which was 
later absorbed into Siemens. 

George Stibitz, a physicist, worked for the Bell Telephone Laboratories, 
and was therefore familiar with telephone relays. He had also 
‘observed the similarity between the circuit paths through relays and 
the notation for binary numbers and had an idea I wanted to work 
out...’ 

He took a couple of relays, a couple of dry cells, torch globes, bits of 
tin and wire, and made a binary adder on his kitchen table. From that 
he went on to develop circuits for subtraction, multiplication and  
division. Complex calculations were needed in the design of long-
distance telephone lines, and Stibitz was asked to design a calculator. 

 

 

 

 

 

 

 

 

In 1939 Stibitz and Samuel Williams built Model 1, with over 400 re-
lays, and a teletype for input and output. In September 1940 it was 
connected via landline to a meeting at Dartmouth College: the first 
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Some Interesting Thoughts 
Sometimes I get the sudden urge to run around naked. But then I just drink 
some Windex. It keeps me from streaking. 
Food has replaced sex in my life--now I can't even get into my own pants. 
Marriage changes passion... suddenly you're in bed with a relative! 
I saw a woman wearing a sweat shirt with "Guess" on it... so I said, 
"Implants?" and she slapped me. 
I don't do drugs anymore 'cause I find I get the same effect just standing up 
fast.  
Money can't buy happiness, but it sure makes misery easier to live with. 
I got a sweater for Christmas... I really wanted a screamer or a moaner. 
If flying is so safe, why do they call the airport the terminal? 
I don't approve of political jokes... I've seen too many of them get elected! 
The most precious thing we have is life. Yet it has absolutely no trade-in 
value. 
There are two sides to every divorce: Yours and dip-shit's. 
If life deals you lemons, make lemonade; if it deals you tomatoes, make 
Bloody Marys. But if it deals you a truckload of hand grenades... now 
THAT'S a message! 
Shopping tip: You can get shoes for 85 cents at the bowling alley. I am a 
nobody, and nobody is perfect; therefore, I am perfect. 
Everyday I beat my own previous record for number of consecutive days 
I've stayed alive. 
If carrots are so good for the eyes, how come I see so many dead  
rabbits on the highway? 

(Continued from page 6) 
time a calculating device had been operated remotely. Other machines 
followed, and Model V was completed in 1946. 

But relays were already outmoded... 

Software 

Programming languages, including AppleScript, have a variable type 
known as Boolean. Two values are possible, true and false 
(represented by 1 and 0). One can then write code such as 

IF number > minimum AND number < maximum  

THEN do_this  

ELSE do_that; 

These days most people’s contact with Boolean logic will be with 
search strings in databases or the Web, with AND, OR, and NOT. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
AppleSauce June 2004  
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Digital phone systems can carry an electric current even when you don't have an active 
connection, so unplug your modem from the phone lines when you are not making a 
connection. As many PC Card modems are extremely sensitive to the high currents of 
digital lines, this can save you an expensive replacement. 
In case 
If you are going to be travelling with your laptop, it really is worth considering investing 
in a proper laptop case with protective walls that help prevent accidental damage from 
bouncing your laptop against objects, and that has room for extra cables and components 
that you may otherwise forget. Your laptop also stands a better chance of surviving a drop 
in one of these. 
Drinks 
While the convenience of a laptop often means you can take it out with you to lunch, try 
to avoid drinking near it. Spills can cause irrevocable damage to the keyboard or 
motherboard and such accidents are generally not covered by warranties. 
Clean-out 
Hard drive space is usually at a premium when it comes to laptops. Don't keep any 
information you don't need. Empty your Deleted Items folder and your Sent Items folder, 
and be strict with the email you do want to keep. Get into the habit of cleaning out your 
web browser cache and deleting the contents of the Windows\Temp directory. 
Duplicates 
If you have a desktop PC in addition to a laptop, creating backups of your important files 
can save heartache later. There are several ways of connecting the machines, ranging 
from small networks to simple serial connections. 
Mirrored 
If your desktop has sufficient hard drive space, create a mirror image of your laptop's 
hard drive on its own partition. This ensures that if you do have any problems you'll be up 
and running again in no time at all. It also means you can be a little more ruthless with 
your paring of unwanted files, folders and applications as you can always refer to the 
mirror image if it all goes wrong. 
BIOS upgrade 
As with desktop PCs, upgrading the BIOS can resolve all manner of problems and add 
functionality. When it comes to laptops, a simple BIOS upgrade can bring an impressive 
amount of additions, including helping the machine to run cooler, better battery 
performance and tuned graphics performance. Upgrading your BIOS can also solve 
incompatibilities that are preventing your system from hibernating properly. Visit your 
laptop manufacturer's website for more information and the requisite files. 
Protection 
One of the downsides of laptops is that they are easy to steal. While there are a number of 
measures you can take to help stop this happening, it's reassuring to know that you are 

(Continued on page 9) 

Portable advice  
Alan Dexter offers tips and advice galore on laptop maintenance and use  Laptops have 
come on in leaps and bounds since their first tentative steps, and now offer a real 
performance alternative to the desktop PC.  
Even so, there are a few troubles that you need to overcome to make your laptop life 
stress-free. Read on for a calmer journey 
Which OS? 
While you will need a fairly powerful laptop to be able to use it, the comprehensive 
power-saving features in Windows XP make it the version of choice for the roaming PC 
user. If you're not interested in lining Microsoft's coffers, then Linux offers a real 
alternative, and modern distributions make installation on a laptop as easy as possible. 
Take a look at www.linuxslate.org installtips.html for an impressive array of advanced 
installation tips. 
Travelling 
While it makes sense to make sure your battery has a full charge before going on any trip, 
you should make sure your laptop has power for security reasons, too. If you are 
travelling anywhere near an airport, security staff will want to check that the laptop is 
working and that you know how to turn it on. This is because bombs have been disguised 
in non-working laptops in the past, and a controlled explosion of your expensive PC is 
not the best way to start a trip. 
Maintenance 
Performance takes on a slightly more important role with your laptop, as the longer an 
action takes, the more power you will use and ultimately the less work you can get done 
in a specified time. For this reason you should keep your machine running as smoothly as 
possible. Run ScanDisk and Disk Defragmenter once a month to help keep your drive in 
optimal condition. 
Slowdown 
If you try installing Windows Me on your laptop after is has been running for a while, 
you may get an error message stating that it can't install because the processor is not at 
least 150MHz. If the processor in your laptop gets too hot, it may slow itself down in 
order to reduce heat production and, in doing so, it may drop its speed below the 
minimum system requirements for Windows Me. The solution is to turn off your machine 
and allow it time to cool down before trying to install Windows. 
Paired 
If your laptop came with two batteries, try to alternate them equally, otherwise the back-
up battery will lose its ability to hold charge due to long periods of inactivity. If either 
battery is not going to be in use for more than a week you should store it in a cool dry 
place and recharge it before use. Even if you mainly use your laptop connected to the 
mains, you should use your batteries periodically to keep them in good condition. 
Connected 
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Any port 
If you use your laptop with more than one docking station, you may find that several 
docking profiles are created on your machine. If you use the same hardware and 
connections from each docking station then this is nothing but an inconvenience. There is a 
workaround for this on most laptops. Enter the BIOS configuration utility, track down the 
setting for Unique Dock ID and disable it. Save the changes and you can use the same 
settings no matter where you dock. 
Iconic 
If you are running Windows 95 and you turn your machine on without a battery connected, 
you won't get the battery icon appearing in the System Tray even if you later install a 
battery. To fix this, select Settings, Control Panel, then double-click the Power icon. Clear 
the Show battery meter on the taskbar box, click Apply, reselect that option and hit OK. 
Hot, hot, hot 
TThe SODIMM memory modules may seem to get quite hot during operation, but don't 
worry, they don't need any additional cooling unless you are trying to overclock your 
laptop. If the heat production is affecting the stability of your system you may need to 
replace your memory. 
Memory 
If you have installed new memory and your laptop is refusing to recognise it, it's worth 
checking you have physically installed it correctly. The installation procedure for this 
memory type is to install it at a 45-degree angle and then push the memory down until it 
locks into the side clips. The first part of this is the critical moment, and it's really worth 
giving the module a firm push into the slot before pushing it down. After installation you 
should see less than 1/16 inch of the gold contact. 
Infra-red 
If you are having problems getting your laptop to communicate through the infra-red port, 
make sure it's been turned on in the BIOS first. Many manufacturers ship laptops with this 
feature disabled. 
Alan Dexter 
 This article first appeared in PC Plus Issue 193 - September 2002 
Please note that the information contained within this article is correct at the time of 
creation. Information may have changed since the appearance of this article in the 
magazine or website. Copyright Future Publishing Ltd Future Publishing Ltd, 30 
Monmouth Street, Bath, BA1 2BW, 
England. Tel: (+44) 01225 442244 Reproduction in whole or in part without written 
permission from Future Publishing is prohibited. This material is for 
personal use only. 

(Continued from page 8) 
fully covered should the worst happen. Write down the serial number of your laptop and 
keep it with your receipt. It's also worth checking that your insurance covers the device if 
it is away from the home. 
Docking 
If your laptop didn't come with a docking bay, this doesn't necessarily mean that one isn't 
available. The additional connectivity and options that these offer can turn your portable 
powerhouse into an impressive desktop, too, so it's worth checking with the machine's 
manufacturer to see if one is available. 
Manually configure profiles 
Hardware profiles make switching between a docked and undocked laptop a breeze, once 
you've set them up. Attach your laptop and boot into Windows. Right-click My Computer 
and select Properties. Select the Hardware Profiles tab on the System Properties screen. 
Rename the Original Configuration entry to Docked. Select the Docked profile and hit 
Copy. Call the new profile Undocked. Click the Device Manager tab and double-click a 
device that isn't available when you are Undocked. Click the Undocked box to clear it in 
the usage area. 
Battery life 
It's a common misconception that laptop batteries are designed to last as long as the 
laptop itself In fact, most rechargeable batteries will last for about two years, although 
this does depend on the technology used, and how you have cared for it. A good indicator 
is when it can't hold its charge for a quarter of the time that it originally did. So if your 
battery originally provided two hours of use, and now only provides half an hour, you 
know its time to buy a replacement. Nickel-Cadmium (NiCad) batteries have a life cycle 
of up to 700 charges. This technology suffers from the memory effect - that is, it will 
charge to the level at which the battery was last discharged. The solution is to fully 
discharge the battery until your laptop shuts off, and then recharge it. Nickel-Metal 
Hydride (NiMH) batteries don't suffer from the memory effect, but can only be recharged 
up to 500 times. The first few times you charge these batteries you should elect to slow 
charge them. The newest battery technology is Lithium-Ion (LiIon), which has a life 
expectancy of five years and can withstand over 1,000 recharges. These batteries are 
expensive, though... 
Pointed 
The pointing solutions for laptops range from the bizarre to the ridiculous, with little 
room for useful in between. While there are some devotees of the touch pad, for the most 
part this should only be used when you're on the move, relying on a mouse for the rest of 
the time. It's a good idea to disable the default pointing device when using the mouse (to 
stop moving the pointer around by accident with the heel of your palm). To do this you 
need to pop into the Device Manager, expand the Mouse branch, select the default 
pointing device, click Properties and then tick the Disable in this hardware profile option. 
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‘I am Dr. Bakare Tunde, the cousin of Nigerian Astronaut, Air Force 
Major Abacha Tunde. He was the first African in space when he 
made a secret flight to the Salyut 6 space station in 1979. He was 
on a later Soviet spaceflight, Soyuz T-16Z to the secret Soviet 
military space station Salyut 8T in 1989. He was stranded there in 
1990 when the Soviet Union was dissolved. His other Soviet crew 
members returned to earth on the Soyuz T-16Z, but his place was 
taken up by return cargo. There have been occasional Progrez 
supply flights to keep him going since that time. He is in good 
humour, but wants to come home...’ 

There never was a Salyut 8: after Salyut 7 came Mir, and of course Mir 
no longer exists. You can read the rest of the story at <www.
theregister.co.uk/2004/04/16/cosmic_419er>. Never believe a word of 
any Nigerian sob story. 
AppleSauce June 2004  
 

The Windows world has been dealing with the Sasser worm in recent weeks: yet 
another piece of malicious code turned loose by someone socially deficient. 

Came across this the other day: 

‘[Harold Thimbleby] points out that you can gain some protection by using 
computer systems that other people don’t use. The usual justification for 
purchasing today’s numerically dominant personal computer is simply and solely 
that it is numerically dominant. Almost every knowledgeable person agrees that, 
in terms of quality and especially user-friendliness, the rival, minority system is 
superior. Nevertheless, ubiquity is held to be good in itself, sufficient to outweigh 
sheer quality. Buy the same (admittedly inferior) computer as your colleagues, 
the argument goes, and you’ll be able to benefit from shared software, and from a 
generally larger circulation of available software. The irony is that, with the 
advent of the virus plague. ‘benefit’ is not all that you are likely to get. Not only 
should we all be very hesitant before we accept a disk from a colleague, we should 
also be aware that, if we join a large community of users of a particular make of 
computer, we are also joining a larger community of viruses — even, it 
turns out, disproportionally larger.’ 

Dawkins, R, ‘Viruses of the Mind’ in A Devil’s Chaplain, Phoenix, 
2004, p 156 

Richard Dawkins is known as a Mac user, and what he originally wrote 
in 1993 is still true, apart, perhaps, from the reference to floppy disks. 

The Mac is a less tempting target, but that should not lead to 
complacency: keep up with the security updates and so on. A couple of 
Web sites have tutorials: 

MacDevCenter ‘A Security Primer for Mac OS X’ by Frangois Joseph 
de Kermadec [Feb. 20, 2004] <www.macdevcenter.com/pub/a/
mac/2004/02/20/security.html> 

MacZealots ‘Complete Mac Security’ <maczealots.com/tutorials/> 

If you follow the stream of advance fee fraud e-mail messages you 
may be aware of the recent one about a stranded Nigerian cosmonaut: 
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The editor in the box:   
Editing tools in Word  2002 By The Crabby Office Lady    
The best way to avoid the swath of an editor's thick red pen is to make sure the copy you 
send is perfect. But if perfection isn't possible, Microsoft Word 2002 offers a variety of 
editing tools to ensure harmony between writer and editor. Applies to  Microsoft Word 
2002  
They're our best friends and our worst enemies. They're the monkeys on our backs and 
the guardian angels on our shoulders. We love them, we hate them, we can't live without 
them. That's right, folks: They're our editors— as well as our reviewers, collaborators, 
and anyone else who has free rein to review and critique our docs.  
And since it harkens back to the olden days to use those archaic proofreading marks (is 
that the roar of flame mail in the distance I hear?), there is a faster, smoother, and more 
efficient way to work together.  
You and your editor have many different ways to collaborate using editing tools in 
Microsoft Word 2002. Below are a few features that are most commonly used. As you 
become familiar with them, you just may find yourself exploring how to better hone your 
editing process.  
Employ the basics: Spelling and grammar If you're the writer, before you hand over 
that piece of your soul to your editor, making sure that your words are spelled correctly 
and that your sentences make sense structurally serves to speed up the editing process. To 
run the spelling and grammar checkers automatically On the Tools menu, click Options, 
and then click the Spelling & Grammar tab. Select the Check spelling as you type check 
box. Select the Check grammar as you type check box. Note You can always choose to 
turn off the grammar checker or the spelling checker. There is no law saying that they 
both have to be on. Between you and me, that grammar checker can be a bit of a 
taskmaster. "But how," you may ask, "How does Word know how to spell all those 
words, and what if I have some special made-up words because I'm writing a science 
fiction novel and don't want the spelling checker to get all hung up on these words of 
creative genius?" I have two words for you: Custom dictionary.  
(If J.R.R. Tolkien were alive today, I'll bet he'd have one doozy of a custom dictionary.) 
With this handy little feature, you can add any word (including made-up words such as 
"Snerfaloid" or "BetagammaC3po") and the spell checker will breeze right over them. To 
add your own words to the dictionary  
On the Tools menu, click Options, and then click the Spelling and Grammar tab. 
 Under Spelling, click Custom Dictionaries. 
 In the dictionary list, select the dictionary you want to modify, and then click Modify. 
Click Add for each word or abbreviation you want to add to the dictionary. Note You can 
also create a brand new dictionary, just for the purpose of this novel you're writing. In 
step 3, click New, give your dictionary a name, and start adding words. There is another, 

perhaps quicker way of adding to your custom dictionary: Type the new word once.  If 
the spelling checker doesn't recognize the word, a red squiggly underline will appear 
underneath it. Right-click the word, and on the shortcut menu, click Add to Dictionary.  
Leave your mark: Keep track of changes Let's see things from both sides now: A writer 
has handed off his best work to you, the editor, and now the fun begins. Rather than plod 
through a hard copy and fill it with little proofreading symbols (which might be mistaken 
for hieroglyphics), why not turn on the Track Changes feature (great name for it, eh?) so 
that each change you make can be seen, accepted, or even (gasp) rejected? When the 
piece is returned to the writer for review, each insertion, deletion, and formatting change 
that the editor or reviewer made is tracked. 
 As the writer, when you review tracked changes, you can accept or reject each change. 
You also have the option to reject all changes or accept all changes at once. (Accept all 
changes— that's a good one! Oh, I slay myself.) Here's the best part of it all: As the 
editor, you can display your edits the way you want (by picking font colours, formatting 
options, and so on), and as the writer, you can customize your own display and view the 
edits the way you want. Both of you end up working in a way that suits you, and if all 
goes well, the document becomes a crisp, clean piece of art and no tantrums are thrown 
on the way there. To track changes so everyone understands what's working and what 
isn't Open the document you want to revise or review. On the Tools menu, click Track 
Changes. When the Track Changes feature is enabled, TRK appears on the status bar at 
the bottom of your document. When you turn off change tracking, TRK is dimmed. Make 
the changes you want by inserting, deleting, or moving text or graphics. To change the 
font colour and formatting of tracked changes On the Tools menu, click Options, and then 
click the Track Changes tab. To change the colour and formatting options of your tracked 
changes, in the Track Changes options section, choose the colour and formatting you 
want. There are other options you can fool around with in that dialog box— you have to 
play around with all of them to see what works best for you.  
Try ballooning with Word (or don't) To preserve the layout of your document, Word 
shows some mark-up elements— insertions, deletions, formatting changes, and clever 
comments— in the text of the document. It displays others in balloons that appear in the 
margin. Balloons show insertions or deletions, formatting changes, and comments. 
"Balloons?" you say. "I find them irritating and childish." Well, just hold on, Crabby. 
You can set it up so that comments (as well as insertions, deletions, and other editing 
changes) also show up in the Reviewing Pane at the bottom of your screen:  
On the Reviewing toolbar, click Reviewing Pane. Note To show the reviewing toolbar, 
point to Toolbars on the View menu, and then click Reviewing. Now you can have 
balloons and the reviewing pane. However, if you are still miffed by balloons (Is it a 
circus thing? Do clowns scare you?), you can just turn them off completely:  On the Tools 
menu, click Options, and then click the Track Changes tab. Under Balloons, clear the 

(Continued on page 12) 
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(Continued from page 11) 
clear the Use balloons in Print and Web Layout check box.  
Juggling editors: When your document becomes an editing party Some of you have all 
the fun: You get to work with multiple editors. It's possible to identify and review quickly 
the changes made by the people who reviewed/butchered your document. You can 
display changes or comments by reviewer or by type, and you can also print a list of 
changes made. To display changes or comments by reviewer Make sure the Reviewing 
toolbar is showing: On the View menu, point to Toolbars and click Reviewing. Click the 
Show button, point to Reviewers, and clear all check boxes except for the ones next to the 
names of the reviewers whose changes and comments you want to show.  
Tip To select or clear all check boxes for all reviewers in the list, click All Reviewers. 
What if you just want to see formatting changes and don't give a whit about the 
comments? To display changes or comments by type On the Reviewing toolbar, click 
Show and select the check box next to the type of change that you want to display. To 
print a list of changes made (This last option might be especially useful in creating a list 
of bones you want to pick with the reviewers.)  Open or switch to the document that 
contains mark-up. On the File menu, click Print. In the Print what box, click List of mark-
up. And there you have it. You're on your way to a smoother, more civilized editing 
process.  

PC Plus  

Word field codes revealed 
 
Word field codes revealed Word's field codes can do everything from giving you dates and 
drop-down lists to consecutively numbering tickets, from PC Plus 192, August 2002  
Word's field codes are powerful tools for adding functionality to your Word documents. 
Every time you add a page number to a document header or footer, or an updateable date to  
a document, you're using a field code.  
These field codes represent only the tip of the iceberg of what field codes can do - as you'll 
see in this month's Masterclass.  
We'll look at some basic tools for working with field codes and some handy codes for 
everyday use, including a selection list, some 'Click here' blocks and codes to automatically 
number tickets. 
Field code basics 
When you place a field code like a page number field code into a document the field code 
marks the place where Word displays the current page number for you. If the number of the 
current page changes - for example, if you add another page - the page number displayed in 
the page number field code will be updated to display the new value. Word takes care of 
this updating process for you. 
There are a number of simple field codes like the page number one that you can use in your 
documents. A handy example is the filename field code that you can add to the footer of a 
document. It has an option for including the file's path and this is useful to include on your 
printed documents because it ensures you know the filename of the document and its 
location. 
To add this field code to a footer, choose View, Header and Footer, and click the Switch 
Between Header and Footer button. Click where the filename should appear and choose 
Insert, Field. From the Categories list choose Document Automation and from the Field 
names list choose FileName. 
If you're using Word 2002, click the Add path to filename checkbox and click OK. If you're 
using Word 97 or 2000, choose Options, Field Specific Switches tab, select the \p switch 
and click Add to field and then OK twice. A field code with the document name and path 
will appear. If it displays as {FILENAME \p \* MERGEFORMAT} this is because you 
have field code display enabled. Toggle this option on or off by pressing Alt + F9. 
If you haven't saved this document you'll see the filename, for example, Document1. Save 
the file - the field code will update when you perform a task such as saving and reopening 
the file, printing it or choosing Print Preview. You can manually update it by selecting the 
document (Edit, Select All) and press F9. You can add field codes manually into a 
document, as long as you know the correct syntax for the field code and that you have 

(Continued on page 13) 

QUICKER SHUTDOWN 
. If your Windows XP doesn't shut down as fast as you'd like, one 
alternative might help. Right click a blank area on your 
desktop, click New|Shortcut and in the Create Shortcut Wizard's Type the 
Location of the Item box, type the following exactly without quotes: 
"shutdown -s -t 0". Make sure there is a space before each hyphen and that 
is a numeric character at the end. Click Next and in the Type a Name for 
This Shortcut box, enter "shutdown" or some descriptive title and click 
Finish. You may now use that shortcut on your desktop for a fast shut 
down, made even faster of course if you don't have any programs running 
when you click on it.  
CHANGING CASE IN MS WORD. If you discover you're in the wrong 
case while entering text in MS Word, don't retype, just select (highlight), 
click on Format|Change Case, then choose one of the options from the 
drop-down menu to change to sentence case, lower case, upper case, title 
case, or toggle case  
From Neat Net Tricks  174 1/6/2004 
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Field. 
At the end of the current entry in the text area, and after the \s, type "selectliststyle". You 
can use any name you like but ensure the name used in the field code and the name of the 
 style you create later are exactly the same. Choose the \t switch, click Add to Field and, 
at the end of the current entry in the text area and after the \t, type "Right click and select 
an entry from the list". The text in the text areashould look like this: 
AUTOTEXTLIST "selectlist" \s "selectliststyle" \t "Right  click and select an entry from 
the list" Click OK twice to close the dialog and add the field code to your document. This 
field code will be what you'll click to display a list of selectable entries. Before you can 
do this, you must create the list entries. You do this by typing each entry on a new line of 
the current document. When you've finished, select all the entries and, in the Style box at 
the far left of the Formatting toolbar, type selectliststyle and press Enter. This creates a 
new style called selectliststyle and it's this formatting that will ultimately provide the link 
 between these entries and the AutoTextList field code. Click the Show/Hide button on 
the toolbar to display the paragraph markers at the end of each entry and then select the 
first entry but don't select the paragraph marker. Choose Insert, AutoText, New and click 
Ok - this adds a new AutoText entry - its name is automatically created, too. Repeat this 
 process and create a new AutoText entry for each entry you've typed. When you're done, 
delete the list items but leave the selectlist field code in place. At this stage you'll want to 
 save your document as you're ready to test the drop-down list. To do this, hold your 
mouse over the top of the field code  (selectlist) and wait until the tool tip appears. This 
displays the text you typed in earlier and prompts you to right-click and display the list of 
entries to select from. Once you've created your selection list and tested it you're ready to 
add some functionality to it. All you need to do to create the selection list in future is to 
create the AutoTextList field code and this can be saved as an AutoText entry so it's 
simpler to create. To save the field code as an AutoText entry, create the selectlist field 
code following the instructions above and select it. Choose Insert, AutoText, New. Type a 
name for the entry (selectlist will do) and click Ok. You can now create the field code in 
any document by typing the word selectlist and pressing F3 to replace the text with the 
field code. 
You'll find that this selection list will work well in templates where you want to give your 
user a small number of entries to choose from. Using a selection list reminds them what 
their options are, makes it easy to select one, and ensures accuracy because they're not 
having to type the data in manually. 
Numbering tickets 
You might be planning an event and need to have numbered tickets or you might be 
running a small raffle or door prize. At first appearance Word seems the obvious choice 
for your tickets - you can buy attractive perforated paper to print them on or you can 
create them in a table and then trim each ticket to size. Your problems will begin when 

(Continued on page 14) 

added the curly brackets correctly. Field code brackets must be created by pressing 
Control + F9. To experiment with this, add today's date to a document using a custom 
format. Begin by pressing Control + F9 to create the brackets, then type the remainder of 
the code inside these: 
{DATE \@ "dd MMMM yyyy, dddd"} 
To update the field code, select it and press F9, if the field code itself still displays, press 
Alt + F9 to display the results. It may help you to see what is happening if you set field 
codes to show as shaded on the screen so you can see them more clearly. Choose Tools, 
Options, View and from the Field Shading drop-down list choose Always and click Ok. 
Many of the simpler field codes can be entered using the Insert menu's Page Numbering 
and Date and time options. Others can be accessed when you are viewing the Header and 
Footer area of a document - some are attached to buttons on the Header and Footer 
toolbar and others are accessible from the Insert AutoText menu on the same toolbar. The 
more complex and less often used field codes are accessible from the Field codes dialog. 
It is these field codes that we'll concentrate on. 
Simplifying data entry with Click Here blocks 
When you're creating documents for others to use you'll want them to enter data in the 
correct position. One way to manage this is to use Click 
 here blocks much like those that appear in Word's own Fax templates. They're simple to 
create using the MacroButton field, as you'll see: Click where the user will type the text 
and choose Insert, Field, from the Categories list choose Document Automation and from 
the Field names list choose MacroButton. In Word 2002, click the Field Codes button. In 
the text area after the word MacroButton, type: NoMacro [Click here and type your 
name]. Click Ok and notice the new entry on the page. None of the text after 'NoMacro' is 
required but you'll find the square brackets are useful to indicate the field code prompt. 
Save the file. 
Test the field code by clicking it and type your  name. Notice that the field code text 
disappears and is replaced by your name. You'll find that field codes like this are useful 
for ensuring users type text in the correct position in a template or regular Word 
document. 
Drop-down selection lists 
You'll be used to using selection lists in Windows programs. These let you choose an 
option from a drop-down list of choices. Using Word's field codes you can create your 
own custom selection lists populated with your own range of selectable options in order 
to speed up data entry. To do this, you'll use the AutoTextList field that displays a 
selectable list of options. Begin by choosing Insert, Field, from the Categories list choose 
Links and References and from the Field names list choose AutoTextList. If you're using 
Word 2002, choose the Field Codes button. Immediately after the word AutoTextList, 
type the word "selectlist" (inside double quote marks) - this is the name of the list. Click 
Options, choose the Field Specific Switches tab, choose the \s switch and click Add to 
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one larger than the previous one. You can copy this field code to the remainder of the 
stubs.If you notice, when you've finished copying and pasting, that the numbers don't 
update correctly, select the entire document by choosing Edit, Select All and press F9 to 
update the field codes. Once you've printed the first sheet of labels, display the field codes 
by pressing Alt + F9, alter the starting number in the field code in the top right of the 
table, press Alt + F9 to return to viewing the results. Choose Edit, Select All, press F9 and 
you're ready to print the next lot of tickets.  
Header and footer options 
Field codes can be used to create custom text for headers and footers and they enable you 
to get some neat effects that otherwise wouldn't be possible. Here are three ideas... 
Sometimes, instead of the current page number, you might prefer the footer to display the 
page number of the next following page. Do this with a field code that looks like this: {if 
{page}={numpages}"/...ends""/...{={page}+1}"}To add a record of the time and date the 
document was printed on the last page of a document, use a field code that looks like this: 
{if{page}={numpages} "Last Printed: {date \@ "ddMMMM yyyy"}" ""} 
Use options from the collection of Document information field codes you can display 
information such as file size and word counts in the Footer area. Select the code to use 
and click the Field Codes, then the Options button to see what options are available. 
There's a wealth of useful things Word's field codes can do for you and the ones we've 
used this month are a small sample of their power. 
Helen Bradley 
This article first appeared in PC Plus Issue 192 - August 2002 
Please note that the information contained within this article is correct at the time of 
creation. Information may have changed since the appearance of this article in the 
magazine or website. 
Copyright Future Publishing Ltd 
Future Publishing Ltd, 30 Monmouth Street, Bath, BA1 2BW, England. Tel: (+44) 01225 
442244 
Reproduction in whole or in part without written permission from Future Publishing is 

Ivan Says: 
A chap named Rod has written in re scanning 
negatives. He has had success using a regular 
scanner by placing the negative on the scanner, then 
placing a mirror face down on top of the negative. 
That way the scanner light passes through the 
negative, bounces off the mirror, and is picked up by 
the scanner’s CCD (charge-coupled device) sensor. 
Rod originally used the shiny side of aluminium foil, 
but a mirror works better, he says. 
Thank you, man. From ACT APPLE JUNE 2004 

(Continued from page 13) 
you try to automatically number your tickets and if you need automatically numbered 
tickets where each ticket has a stub to be numbered, too. 
The solution is to use a field code that will automatically create the numbers for you. 
Begin with a Word document that has a table containing four rows and two columns - use 
Insert, Table in order to do this. Narrow the width of the first column by dragging on the 
divider line to provide a small 'stub' area leaving the larger column to be the ticket itself.  
To make the tickets all the same size, drag the bottom border of the table downwards until 
it appears just above the margin at the foot of the page. If you have the rulers showing 
(View, Rulers), you can see where the margin is. Distribute the remainder of the rows 
equally across this area by clicking somewhere in the table, choose Table, Select, Table to 
select it and then choose Table, AutoFit, Distribute Rows Evenly. Decorate and type the 
text for your tickets and the ticket stubs, leaving room for numbering. Begin with the first 
ticket stub that will be the first cell in the table. Click in it where the first number should 
appear. Choose Insert, Field, from the Categories list choose Numbering and from the 
Field names list choose SEQ. If you're using Word 2002 click the Field Codes button. In 
the text area, after the word Seq, type the word TicketNumber. Click Options, choose the 
Field Specific Switches tab, select the \r field and click Add to Field. This enables you to 
set a starting number for your tickets, we'll start them at 5,000 for now, so type 5,000 and 
 click Ok twice. The field code should look like this: 
{SEQ TicketNumber\r 5000 \* MERGEFORMAT} 
Once this is done, the next code will be added to the first ticket and it will simply repeat 
the first number. To create this field code, click in the first ticket and choose Insert, Field, 
from the Categories list choose Numbering and from the Field names list choose SEQ. If 
you're using Word 2002, click the Field Codes button. After the word SEQ, type 
TicketNumber (this is the variable name you're using for this numbering sequence and it 
will stay constant throughout). Click Options and, again, choose the Field Specific 
Switches tab. Click the \c field, click Add to Field, then click Ok twice. The \c field 
inserts the nearest preceding auto sequence number that is the number from the previous 
stub. The result is that the ticket now contains the required 'duplicate' number. Repeat this 
last step for all the tickets in the document (or, more simply, copy the field code from the 
first ticket and paste it into all the other tickets on the page). 
Stub it out 
The stubs are another issue because the second stub must now contain a number one 
higher than the previous ticket number. For this, you'll need a third field code. Click in 
the second stub and choose Insert, Field, from the Categories list choose Numbering and 
from the Field names list choose SEQ. If you're using Word 2002, click the Field Codes 
button. After the word SEQ, type TicketNumber and click Options, Field Specific 
Switches tab. Click the \n field, click Add to Field, then click Ok twice. The \n field 
switch inserts the next number in the sequence so the second stub now contains a number 
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The Difference Between the Computer Guys 
And the Civilians 
person who you call when your computer doesn’t do what you want it to. We install 
software, fix printer jams, do those “special projects” for our principal. We have a box of 
cables that we just can’t throw away. Sometimes we live in a computer lab, sometimes we 
have a closet somewhere. If we don’t have any formal designation, it doesn’t matter, 
everyone knows who we are. We are loved and we are hated. We are the computer guys. 
Now, please don’t think I am a sexist. Many times the Computer Guy is not a guy at all. In 
fact, I have worked with many women over the years who the kids called, “The Computer 
Lady.” They have all been excellent at what they do and I have learned from them. Male or 
female, “Guy”, “Lady”, or “Person”, whatever you call us, you call us a lot. What makes us 
different from the rest ? What do we have that others don’t have? Are we wired differently? 
Are we smarter? Is there a special gene? I don’t think so. We aren’t that special. There are 
a couple of things that do set us apart from the Civilians though. People will bring me 
software that I have never even heard of and ask me to make it work on their machine. 
What do I do first? I read the directions. If things don’t go smoothly, I read the directions 
some more. I read the Appendix. I read the Frequently Asked Questions. I read the 
Common Problems and Trouble Shooting. Sometimes I even go on-line. We computer 
guys are the people who actually read the manual. We follow the directions. We do it so 
often that we build up an immunity to Boring. Because, believe me, those manuals are 
boring. Time. Nobody has enough time. People say to me, “I probably could have figured 
this out myself, I just didn’t have time,” or “This would take me a week and you probably 
could do it in just a few minutes.” The truth is, I don’t know that I have more time than the 
Civilians, but I am willing to spend my time helping them. We computer guys have already 
put in hours playing with technology and figuring out how things work. We love doing that. 
When we can use that information to help others, we feel good. “Government Jobs”. 
Those little jobs that seem to pop up every year that your principal or someone else asks 
you to do as a favour. We make award certificates, programs for the musical, room signs 
for Career Day. Why do we do them? Because we said yes one time three years ago and 
people remember things like that. It is very hard to say no to your boss, almost nobody 
does. But it is the other “government jobs” that get you a reputation. People are smart. 
They send their friends to ask you. They ply you with promises of donuts, cookies and 
pizza. If you aren’t careful, you could get appointed to a committee... Intuition, gut feeling, 
a sixth sense, magic. We have it. I have a friend who is a “Computer Lady”. She swears 
that she can work for an hour on a computer and not get it to work, and I can come over 
and do the exact same things she did and make it work. She calls it “The laying on of the 
hands”. Is it real? Frankly, I have just as many failures as success stories, so I don’t really 
believe in special powers. But, over time I do feel that we develop insight. Sometimes the 
information is locked away in your brain and you know the answer but you can’t quite put it 
in words. You try something and the machine works. Hurray! Magic? No, probably just a 
wealth of information that sends you in the right direction. Why would anyone want to 
become the Computer Person? People like us when we help them and it is a nice feeling. 
Hopefully they like us for other reasons too, but there are always people that you never 

see until they have a problem. Over the years I have been the teacher that asks for help, 
and the one that gives help. When I am the one asking for help, I make a point of asking 
how things are going, talking about vacation, family. It is important for my friends to know 
that they are my friends outside of their ability to cure my network rights issue. I have 
developed a philosophy that I hope people will appreciate regardless of what side of the 
Help Desk they are on. My friends and I call it “Can Do”. “Yes, I will try to help you.” 
Support means just that. You are a helper. The idea is to solve the problem so that 
everybody is happy. We have all seen those nasty computer tech guys on Saturday Night 
Live. The reason we laughed is because we know people like that. But it shouldn’t be that 
way. When I need help, I am grateful that the Tech people can solve my problems. When 
they can’t, I call other people for help. Sometimes we “Can’t Do”, we cannot help. That is 
when people get upset. For example, teachers tend to store everything that goes together 
in one place. So, it follows that they put every computer document they have ever used on 
one floppy disk. “Why not, there’s room?” Then you try every technique and every piece of 
recovery software you know to resurrect those files and you can’t do it. Nobody likes to 
take that long walk down the hall to tell someone you couldn’t help them. Kiss those 
cookies goodbye... I also won’t copy software for people to use illegally. If we have the 
kind of licence that allows unlimited copies, by all means. But those are few and far 
between, and nobody wants to get the reputation of being a pirate. I  pay for my iTunes 
music downloads too. After a while you learn that there are some people who are 
“Frequent  Fliers”. They always seem to need help and they always have a nonstandard 
problem. I have mixed emotions about these people. They can be very frustrating. But, 
these people are the ones who are willing to try new things and aren’t afraid. That is why 
they get in trouble. They are also the people we should think about training to be the next 
computer guy. Convert a Civilian! We have all heard the expression, “Information is 
Power”. Some Computer Guys take that to mean that their knowledge is part of some 
mystical cult and cannot be shared with the public. They maintain their position by knowing 
what you do not. I disagree with this. I am perfectly wil ling to teach someone how to un-
jam a printer because that might mean I don’t have to do it next time. If someone wants to 
know, I’ll explain, demonstrate, draw a picture. Maybe they will understand, maybe they 
won’t. I hope they will. If another person understands the computer problems I solve, we 
can bounce ideas off one another and solve problems faster. There are whole Support 
Database systems that are designed to do just this sort of thing. I have often said that if I 
were to pour out all of the computer knowledge I have today into another person, I would 
still be ahead in a week. Because learning about computers is what I do. Civilians don’t do 
that. This year I changed jobs from our Junior High School to our High School. They 
already had their own computer people. “Great”, I thought, “no support, no government 
jobs. I will have it easy.” Also, the High School is on the PC platform, not Mac. So, I figured 
I would pretty much be on my own. Nope. Within a few minutes on the first day I learned 
about the secret underground cult of Mac users in the building. “John, can you come look 
at the machine in my room?” Of course I can.  John Nichols 
(<johnnichols@macusingeducators.com>)     
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Newbie Club Tutorials 
Tutorial ... "Windows XP Upgrade Problems?" Many people (ALL people) 
who upgrade from Windows 98 to XP will experience a bit of a shocker when the 
do so. 
Some of the 'old' software doesn't work. 
In fact my brother had to buy a new printer and scanner! 
Sickeningly some older applications will never work on XP. But there is a 
possible solution. I say 'possible' because there is no guarantee that you'll get all 
your 'old' software to work. 
1: Check your manufacturer's Website to see if they offer an XP upgrade. 
2: Run the XP Program Compatibility Wizard, 
(Method 1) 
>From the Start menu, click Accessories, and then click Program Compatibility 
Wizard. 
Follow the on-screen instructions to select a program, and to specify the 
compatibility options to use when running the program. 
(Method 2) 
Open Windows Explorer (not Internet Explorer) to locate the program. 
Right-click the program's icon, and then click Properties. 
In the Properties dialog box, click the Compatibility tab. 
Select the options you want to use, and then click OK. 
It's recommended that you do NOT run virus detection software, backup 
programs, CD authoring tools, or other programs that install system drivers and 
services, while in compatibility mode. 
If this doesn't help there's a terrific resource available at the "Windows XP 
Software Compatibility Site" http://www.xpsc.net 
If that doesn't solve your problem ... 
Hard luck:-)  
Virus Free Programs 
 You can get free upgrades and programs for your computer from all over the 
Internet. After a re format of my hard drive, I couldn't find the CD containing my 
Epson printer driver. So I went to Epson.com and downloaded it for free. 
But be careful - some downloads from 'non-recognized sites can carry viruses. 
The safest thing to do is download directly from the manufacturer or a recognized 
'safe' download site. If you cannot download directly from the manufacturer or 
supplier, these download sites can solve the problem. 

TUCOWS http://www.tucows.com 
DOWNLOAD.COM http://www.download.com 
Programs on these sites are virus checked and certified as virus - free. 
Tutorial ... "About Slashes" 
A. "Path" What's that? 
The ankle bone connects to the shin bone. The shin bone connects to the knee 
bone. The knee bone connects to the... you know. Well, a 'path' on your computer 
is a series of folders along the way. The path you follow to get to a specific 
resource. Kind of like the various parts of your anatomy connecting to other 
various parts... 
Okay, here's an example: 
C:\My Documents\Recipes\cornbread.txt 
'cornbread.txt' is the file name. It's found in the 'Recipes' folder, which is found in 
the 'My Documents' folder, which is found in the C: folder... which is your hard 
drive. So the 'path' to cornbread.txt goes through the C:\My Documents\Recipes 
forest. 
Why does this matter? 
It's just lingo. But without knowing the lingo, your trip through the Black Forest 
of computers will be filled with terror and frustration. Right? Of course. :-) 
....While we're on the subject of slashes (aren't we?) 
B. "Forward slash - back slash" 
Ever wondered why the slash is forward (/) in a web page URL, and backward (\) 
on your computer? No? Okay. 
All Internet resources use the forward slash to separate one resource from 
another. Page names are separate from domain names. The forward slash 
indicates a 'change in resource'. 
On your home computer, you'll see the slash is backward, or leaning to the left. 
"And never the two shall mingle!" You can try using a backslash in a Web page 
URL. But it won't work. You CAN use a backslash in your browser, like this: 
C:\My Computer 
Do that, and you'll list all the stuff on your computer! But you won't see stuff on 
the Internet that way. Who cares? Someone. Somewhere. 
Tutorial ... "How To Set Up Outlook Express Filters" 
You can filter your email using the filter facility in Outlook Express - or Outlook 
if you use it. 

(Continued on page 17) 
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(Continued from page 16) 
Open OUTLOOK Express. 
Click the Tools menu, point to 
Message Rules and click on Mail. 
In the Message Rules dialog box, click on the New button. 
In the 'New Mail Rule' dialog box, find the 'Where the Subject line contains 
specific words' entry in the Select the Conditions for your rule section. 
Put a checkmark in its checkbox. 
In the 'Select the Actions' for your rule section, find the 'Move it to the specified 
folder entry' and put a checkmark in its checkbox. 
In the 'Rule Description' section, click on the blue/underlined contains specific 
words entry. 
In the 'Type Specific Words' dialog box, type in a keyword or phrase. This must 
be EXACTLY as it reads and spells in the email you wish to filter. 
Then click the Add button. 
Continue to add keywords and phrases until you're done. Then click OK. 
Examine the junk emails you wish to filter and pick out the keywords you wish 
your filters to pick up on. Unfortunately you'll find a lot of the offending words 
are misspelled to avoid being picked up by the filters. 
Click on the blue/underlined specified entry. 
In the 'Move' dialog box, click on the 'Bulk Mail' folder and then click OK. 
In the 'Name of the Rule' section, replace the current name with the name 'Junk 
Filter Rule'. Click OK. 
Click OK in the 'Message Rules' dialog box. 
Normally, when people send email to you, your address is listed. However, Junk 
mailers will sometimes hide the destination addresses, and what you see in the 
To: list is 'undisclosed' and 'suppressed'. 
So you can use the keywords "undisclosed" and "suppressed" in your filtering 
rule. 
A friendly word ... 
Send your filtered emails to a new folder named 'Filtered' at first. Do NOT 
automatically 'Permanently Delete' them. 
Check this folder for a week or so to ensure that you're not trashing legitimate 
emails. 
You can also use this Filtering System to automatically file specific 'friendly' 
emails into a folder of your choice. For instance you can automatically file your 

favorite newsletters to a 'Newsletter' folder which you have created, or filter 
emails from your friend 'Dracula' into your 'Vampires' folder. Tutorial ... 
"Increasing Browser Font Size" 
A few weeks ago I used a 'Newbie's' PC and could hardly read the text on the 
screen, because it was so tiny. 
If you want to change your text size to something more comfortable do this ....  
.......... If you use Explorer ... 
Click 'View' in top toolbar. 
Click 'Font Size' in drop down menu. 
Select from a range of Font sizes to suit your own eyesight 
I use 'medium' but if you suffer from poor eyesight you may wish to use 'larger' 
or largest'. 
.......... B 
Open the Options menu and click General Preferences. 
Once the Preferences dialog box appears, click the Font tab. 
Here, you can choose you Proportional and Fixed fonts, as well as your Encoding 
setting. 
Click OK to save your settings. 
This is an example of how using large font can break up the sentences and 
formatting of some Websites because there will now be fewer words to a line.  

Phatbot suspect released on bail 
Martin Fiutak and Munir Kotadia, ZDNet UK May 17, 2004 
 A man suspected of writing the Phatbot Trojan has been released on bail. The 21-year-
old programmer from Schoenau in Germany who was accused of writing the Phatbot 
Trojan was released on bail on Friday after spending just one week in custody.  
 Phatbot, also known as Agobot, has caused concern among many security experts 
because it allows a single individual to control a vast network of computers, potentially as 
a means to attack commercial Web sites. The coder was captured the previous Friday, the 
same day that an 18-year-old man, also a resident of Germany, was arrested for creating 
the Sasser worm. The man was released after instructions from the German public 
prosecutor's office. Authorities say they do not expect him to jump bail because his 
passport has been confiscated. He is required to check in regularly with the police to 
verify his whereabouts. The preliminary investigation by the public prosecutor's office 
will decide if there is enough evidence to proceed. The programmer, who claimed to have 
worked with a team of coders from all over Germany in order to create the Phatbot worm, 
was arrested after advice from US authorities.  Copyright •0„8 2003 CNET Networks,  
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Cyber Crooks Go 'Phishing'" 
By Jim Edwards - http://www.thenetreporter.com 
==================================== 
"Phishing," the latest craze among online evil-doers, has nothing to do with 
sitting at the end of a dock on a sunny afternoon dangling a worm to entice 
hungry catfish. 
But, if you take their bait, this new breed of online con artist will hook you, reel 
you in, and take you for every dollar you have... or worse. 
"Phishing" describes a combination of techniques used by cyber crooks to bait 
people into giving up sensitive personal data such as credit card numbers, social 
security numbers, bank account numbers, dates of birth and more. 
Their techniques work so well that, according to FraudWatchInternational.com, 
"phishing" rates as the fastest growing scam on the Internet. 
Here's the basic pattern for a "phishing" scam... 
You receive a very official email that appears to originate from a legitimate 
source, such as a bank, eBay, PayPal, a major retailer, or some other well known 
entity. 
In the email it tells you that something bad is about to happen unless you act 
quickly. 
Typically it tells you that your account is about to get closed, that someone 
appears to have stolen your identity, or even that someone opened a fraudulent 
account using your name. 
In order to help straighten everything out, you need to click a link in the email 
and provide some basic account information so they can verify your identity and 
then give you additional details so you can help get everything cleared up. 
Once you give up your information it's all over but the crying! 
After getting your information, these cyber-bandits can empty your bank 
accounts, deplete your PayPal accounts, run up your credit card balances, open 
new credit accounts, assume your identity and much worse. 
An especially disturbing new variation of this scam specifically targets online 
business owners and affiliate marketers. 
In this con, the scammer's email informs you that they've just sent $1,219.43 (or a 
similar big but believable amount) in affiliate commissions to you via PayPal. 
They need you to log into your PayPal account to verify receipt of the money and 
then email them back to confirm you got it. 
Since you're so excited at the possibility of an unexpected pay day, you click the 

link to go to PayPal, log in, and BANG! They have your PayPal login 
information and can empty your account. 
This new "phishing" style scam works extremely well for 2 basic reasons. 
First, by exploiting your sense of urgency created by fear or greed, crooks get 
you to click the link and give them your information without thinking. 
Second, the scammers use a variety of cloaking and spoofing techniques to make 
their emails and websites appear totally legitimate, making it extremely hard to 
spot a fake website, especially when they've first whipped you into an emotional 
frenzy. 
The good news, however, is that you can protect yourself relatively easily against 
this type of cyber-crime with basic software and common sense. 
Most of these scams get delivered to you via Spam (unsolicited email), so a good 
spam blocker will cut down on many of them even making it to your inbox. 
If you receive an email that looks legitimate and you want to respond, Stop - 
Wait - Think! 
Verify all phone numbers with a physical phone book or online phone directory 
like www.Verizon.com or www.ATT.com/directory/ before calling. 
Look for spelling and grammatical errors that make it look like someone who 
doesn't speak English or your native language very well wrote it. 
Never click the link provided in the email, but go directly to the website by 
typing in the main address of the site yourself (example: www.paypal.com or 
www.ebay.com). 
Forward the email to the main email address of the website (example: 
support@paypal.com) or call the customer service number on the main website 
you typed in yourself and ask if it is in fact legitimate. 
Above all remember this: 
Your bank, credit card company, PayPal, eBay and anyone else you deal with 
online already knows your account number, username, password or any other 
account specific information. 
They don't need to email you for ANY reason to ask you to confirm your 
information -- so NEVER respond to email requests for your account or personal 
details.  



Page 19  

Launceston Computer Group Inc. JUN 03-04 
Minutes: Launceston Computer Group Committee Meeting  
Held at Studio Works Pipeworks Road LTN. Wednesday 03JUN04. 
Opening: Pres. Glenn Gilpin , opened the meeting at 6.05 PM.  
Present: Glenn Gilpin, John Frearson, David Gray, Julie Hjort, Ron 
Baker, Chris Ralph, Reinhard Von Samorzewski, Janet Headlam, Wayne 
Gibson  
Apologies: Judy Hall, Ivan Turmine, June Hazzlewood, 
Minutes: 05MAY04. GG/RB PASSED.  
Correspondence: E-mails addressed to the Committee. DG/GG PASSED. 
Business Arising Iris Meek, Judy Hall, leave granted DG/GG PASSED 
Finances: ##***##.   
Dymocks modified Invoice # 631 05/05/2004 $208.78  
Judy Hall for OPEN Active Electronics Invoice 124678 12/05/2004 
$44.99 ³  
Bank balance as at 28/5/04: $7197.34 Iris for OPEN from DG  
There are no unpresented cheques. Income of $1021.05 was received 
during the month the full break up of which is not available at this stage. 
Outgoing: all seven cheques totally $468.12 approved at the last 
committee meeting have been presented.  
Accounts for payment: Iris for OPEN from DG Rent of Rooms $380 with 
more actually due but since we do not have all the figures we will have to 
hold it over to next month.  
Toner Cartridge $140 I do not have the invoice DG.  
I have a statement from National 1 showing an invoice (No. 218931) dated 
4/3/04 for $38.94 I have no copy of the invoice. 
Is it our purchase or could it be someone else's mistaken added to our 
account? DG - been paid.  
The books this OPEN purchased which were never approved by the 
committee. We need to look at this. DG.  
Room cleaning Quotes , 3 required by Fran OPEN petty cash $262.70 DG/
GG PASSED.  
Esk Market:  Book for 20JUNE04, 3 tables for $25  

Computer Show: DTP Technology 1 stand) Tamar Technology 1 stand) 
Unique computers 1 stand) info from J Hall 2004 Computer show not on 
for a number of reasons, has been left to the next Committee All contacts 
to be notified by RB  
New Members: Financial year July to June, but members are financial to 
AGM in August  
2004-05 base fee is $10 per member DG/GG PASSED  
eMail: Being circulated by either an ANNOUNCE, MEMBERSHIP or 
COMMITTEE lists OPEN:  ?  
Account to TAFE for ? courses ? 
OPEN own bank account or report for OPEN minutes 
Membership being printed @ OPEN, $0.20 per A4 sheet side  
Minute book to be set up by WG  
General Business:  
Web site requires updating content, colour, 2002 date removal RVS JF/GG 
PASSED.  
LCG letterhead with OPEN incorporated reqd  
Meeting Close: 7.36 PM.  
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Remove *Any* Software 
This question targets one piece of software, but the answer's general, and 
can work on any software that just won't uninstall properly. 
Dear Fred, Add/Remove doesn't want to remove Spybot. It's listed there as 
1.1 but the program itself says it's 1.2. How do I get rid of it so I can 
download and install the 1.3 version? Thanks. ---Chris Aichelman 
Sometimes, old software won't uninstall properly. Other times, it does 
uninstall, but the "Add/Remove Software" list doesn't refresh: the software 
shows as installed, when it's not. Both problems aren't that hard to fix. 
If you've been unable to uninstall via Control Panel's "Add/Remove 
Software" list, or via the program's own Uninstall applet, start by making a 
backup or (even better) an image of your hard drive. 
Next, do a full search of your hard drive for any files or folders relating to 
the software in question: For example, search for anything containing the 
program's name or the owners/publisher's name. In the case of Spybot, it's 
easy: A search for any file or folder with "Spybot" in its name will turn up 
Spybot's folders and main files. 
When you've found where the target files/folders are located, delete them 
all. 
Next, use your Registry tool (eg Regedit) and search the Registry for any 
entries relating to the software in question. Again, you usually can find 
these by searching for anything containing the program's name and/or the 
owners/publisher's name. Delete any entries relating to the target software. 
Reboot, so any in-use files will be released. Watch for any error messages 
at reboot: If they occur, they may contain clues as to the names and 
locations of any scattered files or settings you may have missed in the 
previous steps. Delete any such files you find this way, and/or change the 
affected settings (eg via Start/Run/MSCONFIG) that refer to the deleted 
files. 
If you're being extremely thorough, do a second search of the drive and 
Registry to make sure that you really got everything the first time. Run 
your favorite Registry-checker--- jv16, WinDoctor, or whatnot ( http://
www.google.com/search?q=registry+check+repair ) to detect and repair 

any entries orphaned by your manual deletions. 
The software should now be fully gone, but it's possible that there'll still be 
a ghost entry listed under Control Panel's "Add/Remove Software" list. If 
this happens, navigate to this Registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\Uninstall 
You can remove any item listed in the "Add/Remove" tool on Control 
Panel simply by deleting the appropriate subkey in the above. In the 
subkeys, "DisplayName" is the name you see listed in the Add/Remove 
Programs tool, and "UninstallString" is where the uninstall program is 
supposed to reside. 
If you delete something this way, make a note to see where the Uninstall 
program is supposed to be: Check to make sure you deleted that file/folder, 
too. 
When you're done, your system should be free of the files you were trying 
to delete, as well as any references to those files. This way, you should be 
able to remove even the most stubborn, deep-rooted software! 

That Error 
I was having trouble with my computer. So I called Rick the computer 
guy, to come over. Rick clicked a couple of buttons and solved the 
problem. He gave me a bill for a minimum service call. As he was walking 
away, I called after him, "So, what was wrong?" 
He replied, "It was an ID ten T error." 
I didn't want to appear stupid, but nonetheless inquired: "An ID ten T 
error? What's that . in case I need to fix it again?" The computer guy 
grinned.... "Haven't you ever heard of an ID ten T error before?" 
"No," I replied. 
"Write it down," he said, "and I think you'll figure it out." 
  
So I wrote out .. I D 1 0 T  


